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1. Overview 

Boosting up your sales with digital signage is no longer a complicated 

task. SignApps Express is the world's easiest digital signage software that 

can help you put the right messages to the right place immediately.  

The software features professional pre-designed templates, auto 

discovery of digital signage devices, and an intuitive WYSIWYG (what you 

see is what you get) user interface that anyone can learn and use in no 

time. Simply choose a template, upload your media content, and click to 

export to your players on the network. 

 

Digital signage made easy with SignApps Express.  
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2.  Installation 

2.1 Minimum system requirements 

Windows Vista, 7, 8 or 10 Operating System 

.NET Framework 4 

(optional)Microsoft PowerPoint 2003/2007/2010/2013 

2.6 GHz CPU 

2GB of system memory ( 4GB recommended ) 

200 MB available storage space 

3. Setup process 

Run the installer and follow the step-by-step instructions. 
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4. UI Overview 

4.1 Main Menu 

The main menu is composed of a list of existing playlists and a list of 

players available for playlist assignment. 

 

 

You can drag players into and out of a playlist to make it associated/ 

unassociated with the playlist. Double click a playlist to edit. 

When mouse cursor is over a playlist, an "X" button will show up. Click the 

"X" to delete playlist. 

Maximum 50 players can be associated with a playlist. 
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4.2 Player Model 

Select a player model for model specific playlist or Select All models for 

general playlist supported by all devices. 

 

4.3 Template List 

Template list contains all the presentation templates. 
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4.4 Presentation Editor 

Presentation editor allows you to edit all the media content: text, image, 

video and widget in a presentation. 

It also allows you to save and export the playlist to the players or USB. 

Click Edit Schedule if you need to create a playback schedule. 

 

 

`   
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4.5 Schedule Editor 

Schedule editor helps you create flexible playlist containing multiple 

presentations which will play automatically according to pre-defined 

events (time slots). Users can add up to 50 event schedules and up to 50 

presentations in a presentation loop.  
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4.6 Event Editor 

Event Editor lets you define how and when each event will take place. 
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4.7 User Operation Flow  
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4.8 Edit Playlist 

4.8.1 Create playlist 

1. Input a playlist name (optional) and then click Create playlist.

 

2. Select Player Model Type 
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3. Double click a template to make your selection. 

 

To edit from an existing playlist  

Double-click on an existing playlist to edit.  
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4.8.2  Duplicate existing playlist  

Click the Duplicate button on an existing playlist to copy it. 
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4.9 Edit Presentation 

4.9.1 Add looping playback media items by drag and drop  

Simply drag and drop media from file explorer to the zone. 

 

 

4.9.2 Add looping playback media items from panel  

1. Select a zone and the Looping playback option panel will expand. 
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2. Add new image/video/powerpoint/widget and edit their options. 

Click  to add more media to the zone. 

Click  to add special media to the zone:  

 Widget  

      A/V input 

4.9.3 Media item configuration 

1. Focus/Zoom (image only) and Fit option can be configured from 

editing zone directly. 
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2. Playback duration and other options can be configured from Option 

dialog, to launch the Option dialog:  

◦ Double click on media item  

◦ Click right mouse button and select Option.. 

 

4.9.4 Edit image 

1. Add image file to a zone and click on the item in the looping playback 

media list to start editing . 

  

Note: 

To select multiple 

items, click the first 

item, press and hold 

down the Ctrl key, and 

then click the next 

item 
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2. You can replace the image, zoom-in/out and adjust the focus. Click 

confirm when you are done 

 

 

Configurable 

options 

Options 

Duation Playback duration (seconds) 

  

Display 

option 

 

 

Crop (default option which allows user to change focus 

freely) 

Fit (fit image inside the zone and maintain its aspect ratio) 

Stretch (fill image inside the zone without maintaining its 

aspect ratio) 
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4.9.5 Edit video 

1. Add video files to a zone and click on the item to start editing. 

2. Configure display option : 

 : Fit inside 

 

 : Stretch 

 

 

Note: 

Double click the video 

to preview the 

playback in Windows 

application 

Note: 

Only ONE zone is 

allowed to contain 

video files in a 

presentation 
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Configurable options Options 

Display  Fit/Stretch 

 

4.9.6 Edit PowerPoint file 

1. Add powerpoint file to a zone and click on the item to start editing.  

 

 

 

 

2. Choose to fit inside the zone or stretch PowerPoint to the zone: 

 : Fit inside 

 : Stretch 

Note: 

Export PowerPoint 

slides (static images 

only) if you have 

PowerPoint 2016 or 

later installed in same 

computer 
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Configurable options Options 

Display Fit/Stretch 

Unspecified slide 

duration(*) 

Playback duration for each 

slide(seconds) 

4.9.7 Edit Logo 

Click on LOGO icon to edit LOGO.  

(LOGO only supported in select Templates)  

 

 

3. You can replace the image, zoom-in/out and adjust the focus. Click 

confirm when you are done. 

 

* When there is no 

specific playback 

duration for each slide 

in PowerPoint settings. 

Note: 

LOGO zone does not 

support looping 

playback  
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4.9.8 Edit Widget  

Add widget files to a zone and click on the item to start editing. 

Configurable 

options 

Options 

Common 

Options 

Playback duration : seconds  

Color: background color 

foreColor: text color  

Clock timeFormat : 12h/24h 

Calendar timeFormat : 12h/24h 

Align: right/center/left 

Weather Cities: choose from pull-down list or type the city 

name listed in this web page -  

http://www.worldweatheronline.com/country.a

spx (verify link — may be outdated)   

Scale : C/F  

Key : worldweather online API Key(Pease see note) 

RSS Urls: RSS URL 

Writing direction:Right to Left/Left to Right 

Color: test color 

Title-Length: Non-integer 

Content-Lenth: Non-integer 

Webpage URL: website URL 

Advanced Clock* 

 

 

 

clockSkin: *.jpg, *.png, *.jpeg 

showDate: True, False 

dateFormat: Format of date 

 

 

 

 

 

 

 

 

Note 

Every API key has the 

limited times to query 

information from the 

website. Users can sign 

up to get the location 

search weather API by 

using the link below. 

https://developer.worl

dweatheronline.com/a

uth/register Note: 

Verify this link is 

current before 

publishing — 

WorldWeatherOnline 

has updated their 

registration portal 

since this manual was 

written. 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.worldweatheronline.com/country.aspx
http://www.worldweatheronline.com/country.aspx
https://developer.worldweatheronline.com/auth/register
https://developer.worldweatheronline.com/auth/register
https://developer.worldweatheronline.com/auth/register
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*  Unsupported models: 

XMP-2200/2300/2400, XMP-

3250/3350/3450 and XDS-

1060/1062/1068 

dateColor: Date text color 

showSweepHand: True, False 

secondHand Color: Second hand color 

backgroundColor: The background color of 

whole region 

handColor: Color of minute hand and hour hand 

 

4.9.9 Adding Ticker  

1. Choose one of the empty templates to use ticker. 
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2. In the Tools panel, check Ticker to enable it. 

 

3. Select a preferred ticker mode from one of the options: 

 

Personal text:  

     To display text content from a .txt file. 

Widget: 

     To display a widget in the ticker zone. 

    (ex. RSS widget or custom widgets) 

Configure personal text – 
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Configurable 

options 

Options 

File Path to the .txt file 

Duration Playback duration in seconds 

Size The text size of the ticker 

Available options: small/normal/large 

 

Effect Transition effect of the ticker 

Available options:  

Static: no transition effect between lines 

Crawl: ticker crawls from right to left 

Scroll: ticker scrolls up 

 

Background color Select ticker zone background color from 

color palette 
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Background 

opacity 

Level of transparency of the ticker 

background 

Text color Select text color from color palette 

Writing direction  Left to right/Right to left 

  

 

After enabling the ticker, you can: 

1. Change the location of the ticker to Bottom or Top. 

2. Add additional .txt files or widgets to the zone. 

 

  



 

  

 

 

 

 

 

 

29 

 

SignApps Express User Manual 

Copyright©2020 IAdea Corporation. 

4.9.10 Edit text 

1. Editable text is highlighted with a yellow box when you hover over it. Click the 

text to start editing. 

 

2. Expand option to change font type, size and color. 

 

3. If the text belongs to a text group, changing its style would affect on 

all text in the same group. 
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4.9.11 Switch theme and Toggle logo display 

Expand Tools panel to toggle logo display and choose a different 

color theme. 

 

4.9.12 Adding background music 

Background music only works with image/PowerPoint presentation. If 

presentation contains video, an information message will show up to ask 

user to remove video from presentation before adding background music. 
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4.9.13 Switch between presentations  

If more than one presentation exists in same event schedule, switching 

between presentations can be done by the switch as shown below.  

 

 

 

 

4.9.14 Interact with LED light bar 

When selecting HD 10” signboard (1280 x 800) layouts, LED light bar 

control is available for certain models of signboards. 
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Enable the light bar to blinking constently: 

 

Or interact it with contents: 
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4.9.15 Video Streaming on 4K Media Player 

➢ Spec: RTSP H.264 video streaming 

➢ Application: Stadiums, Flight Information Display, Entertainment TV 

➢ Supported model: XMP-7300 
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Capable of streaming RTSP video stream from local server. 
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4.9.16 Edit Media URL 

Benefit 

• Update content remotely by replacing the media file on HTTP/FTP. 

• Does not require all files to be stored on local PC. 

 

 

Spec: 

• Accept video and image URL from HTTP or FTP server. 

• Accept URL with or without basic authentication. 
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4.9.17 Synchronize Playback 

 

4.10 Edit Schedule 

Click Edit schedule to enter schedule editor. 
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4.10.1 Add an event schedule 

1. Click Add event schedule. 

 

2. Edit the event schedule. 

  

  



 

  

 

 

 

 

 

 

40 

 

SignApps Express User Manual 

Copyright©2020 IAdea Corporation. 

3. Select template. 

 

4. Edit the newly added presentation. 
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4.10.2 Edit recurrence type 

Edit the event schedule by specify the event name, event type, 

recurrence type and playback period. 

 

 

 

 

 

 

 

 

 

 

Specific days(s) event has the highest priority. 

Monthly recurrence has the 2nd highest priority. 

Weekly recurrence has the lowest priority when schedules are 

overlapping. 
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Weekly: Select the days of week you would like to create schedule for. 

 

Monthly: Enter days separated by a comma. For consecutive dates, use 

dash to separate start and end dates.  

Ex: 1,5,9,15-18 will play on 1st ,5th ,9th ,15th ,16th ,17th , and 18th of each 

month. 

 

Specific day: Pick start day and end day from the calendars. 
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4.10.3 Schedule priority 

 

➢ Default presentation is the initial schedule which is designed to play 24/7. 

It has lowest priority and will be surpassed whenever there are 

overlapping schedules. 

➢ As shown on diagram above, specific day(s) event has the highest priority 

for playback when the schedules are overlapping. Monthly schedule has 

2nd highest priority, then it's weekly schedule. 

➢ Among same recurrence type, newest added schedules will take higher 

priority ( e.g. Weekly 2  is the newly added schedule ).  
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4.10.4 Add presentations to an event 

1. Click Add presentation.

 

2. Select template. 
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3. Edit the newly added presentation.

 

When looping presentation has more than 1 presentation, duration box 

will appear. Click on Presentation duration number (300) to change 

duration, default duration is 300 seconds.  
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4.10.5 Duplicate a presentation to an event 

Right click on presentation and select Duplicate to, then select a 

destination. 

 

4.10.6 Duplicate an event 

1. Right click a schedule and select Duplicate or click duplicate button of 

a schedule. 
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2. Edit schedule of new event 

 

3. Click OK to save new event 
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4.10.7 Adding trigger event 

Enable event trigger and add trigger to current presentation 

 

Trigger Event lets you to add event trigger into presentation, the trigger 

source can be touch button event and motion sensor event from smart 

signboard, or input event from PIO-101. 
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4.10.8 Send power on and standby RS-232 command to display 

Select a playlist and launch the configuration menu from Tools -> Enable 

serial protocol (RS232) as shown below. 

 

Configure baud rate, send EOL , video on ( display power on ), video off 

( display standby) as shown below. Each playlist can use a serial protocol 

to manage display power on/off. The configured values of the serial 

protocol could be modified once the protocol be selected and enabled. 

Please consult display manufacturer for the necessary configuration and 

serial commands. 
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4.11 Export Playlist 

4.11.1 Export playlist via USB 

Click export button and click Export to USB, and then select the correct 

location for export. 

 

Note: 

SignApps will 

remember your action, 

so next time you only 

need to click ‘Save’ 

to export 
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4.11.2 Export playlist via Network 

1. Click export button and click Export to player. 

 

2. Select devices on your network or add them by typing their IPs 

 

  

Note: 

If a player is already 

associated with 

another playlist, it will 

show what playlist 

being associated 

previously here  
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3. Export runs in the background, allowing you to navigate away and continue other 

tasks while the playlist is exporting. 

 

 

Exporting status displays in main menu as well: 
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4.11.3 Export playlist via Cloud 

To export via Cloud, see Section 4.12 SignApps Cloud Update Function. 

1. Click export button and select Export to Cloud and Select your 

Cloud folder.

 

2. A Cloud Playlist Notice will appear. Once a playlist is converted to a 

Cloud Playlist, it loses certain local playlist privileges and cannot be 

saved locally or loaded on another computer. Save the playlist 

locally before converting.
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3. Players that are connect to your SignApps Cloud account will 

populate. To differentiate between local and cloud players, cloud 

players will only display MAC ID or player name. Local players will 

still display IP address. 

 

4. Playlist will export to the Cloud first. Then the players will download 

from the server. Cloud Player will display a downloading icon and 

display Online when complete. 
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5. Cloud Playlist will display Last Export/Download Time stamp. It will 

also display Associated Players and Cloud Playlist Icon. 

 

❖ Device heartbeat under cloud playlist will display heartbeat 

information from the cloud server. For example, if the player is in 

your LAN but loses connection to the network, it will show as 

offline. 

  

Cloud playlist  
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4.11.4 Player association 

After export, the players are associated with the playlist and will be listed 

under the playlist in the main menu. 

You can also assign player to playlist by dragging player and drop to 

playlist in the main menu. 

❖ Cloud Players can only be assigned to Cloud Playlist.  

❖ Local Players can only be assigned to Local Playlist. 
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4.12 Save / Load Playlist 

4.12.1 Save playlist(s) 

To migrate your playlist to another computer can be done easily with 

save / load playlist function. You can save multiple playlists at main menu. 

Providing save location and file name to saved playlists, then click on save 

when ready. 

 

 

Or you can save individual playlist when editing the playlist: 
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4.12.2 Load playlist(s) 

Load the playlist to software from File menu. Press ctrl + select playlist 

files to load multiple playlists at once. 

 

4.12.3 Save/Load Cloud Playlist 

Cloud playlist cannot be saved and loaded through Save/Load playlist 

feature. Cloud playlist will automatically be saved and loaded once 

SignApps Account is logged in. 
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4.13 SignApps Cloud Update Function 

4.13.1 Initial Setup 

1. From the Tools Menu, select Configure Cloud Server.

 

2. Login with your IAdeaCare credentials.
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3. On your initial login, you will need to select the closest region to 

you (This will allow for the most efficient upload and downloads to 

and from the cloudserver). Then, you will need to name your Cloud 

Folder. Finally, please configure how often you want the software 

to check the server for updates. 
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4.13.2 Cloud Server Dashboard 

 

❖ For IAdeaCare, see IAdeaCare user manual. 

  

https://support.iadea.com/hc/en-us/articles/360001204663-IAdeaCare-user-manual-
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4.13.3 Adding Cloud Update License 

1. In Cloud Server Dashboard, select Manage License and log into 

your IAdeaCare account. Go to License Tab, Select Player, and Add 

License via CLOUD license.  
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2. Activated Cloud License will populate under the Miscellaneous 

Section of the License Tab. 

 

3. Once players are registered to your IAdeaCare account and the 

Cloud Licenses are activated, the players will automatically 

populate in SignApps when logged into the SignApps Cloud 

function. 
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4.13.4 SignApps Cloud Limitations 

• Storage Limitation 

• 10GB for 1st player, + 1GB per additional player. 

(Purchase additional storage by adding more player 

licenses) 

• Storage will auto-purge storage along with content 

changes in playlist. 

• When storage approaches maximum cap (less than 

10%) customer will receive a reminder email. 

• When storage is over the limit, export will fail and 

error message will be sent to email. 

• Player limitation 

• Can connect up to 500 media players. 

• License expiration 

• Reminder email will be sent 4 weeks before license 

expiration date. 

• After license expires, user will not be able to update 

new content to the expired player. The expired player 

will continue to play last downloaded content. 
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4.14 Configure Player 

4.14.1 Features 

➢ Install players first, then configure all devices at once with Ethernet 

connection. 

➢ Easily change device settings remotely. (Static IP, Domain) 
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4.14.2 Device Configuration 

Configure general and network settings on devices all at once. 

 

  



 

  

 

 

 

 

 

 

68 

 

SignApps Express User Manual 

Copyright©2020 IAdea Corporation. 

4.14.3 Device Troubleshooting 

Download DEBUG logs and send to IAdea support.  It will also allow you 

to get a screenshot and reboot the device. 
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4.15 Firmware Update 

1. Go to Help → Firmware update, select the Firmware package and click 

OK 

2. Select the player you need to update  

Firmware package can be downloaded from https://support.iadea.com 

 

 

 

 

 

https://support.iadea.com/hc/en-us/categories/201723426-Firmware-Software-Download-
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4.16 Widget Update 

4.16.1 Update the widget 

Click the 'update widgets' to update widget from 'Help'. 

You will see Widget Update' dialog shown to let user choose the widgets. 
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Left panel show available widget(s) to update (support multi-select). 

Right panel show the update information when user choose a widget 

from the left panel.. 
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When click download, SignApps will ask if to keep only the latest version 

for updated widgets. 

 

 

Options Results 

Yes All old widgets will be removed, only the new widgets 

will be reserved. 

No Keep both the old widgets and the newly updated 

widgets. 
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4.16.2 Use the widget 

If a widget has another old version, user could choose the old version.  

The 'Select other widget' button is for user to select other local widgets. 
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4.17 Layout Editor 

1. Click 'Create new layout' from 'Tool'. 

 

 

2. Click 'New' to create a new layout. 
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3. Input the Company name, the size of the layout and choose Zone 

count from drop menu 
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4. Edit the global settings, background and anchor info. 
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5. Make sure to add the background to each zone then click 'Save' to 

save the template. 
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6. Go back to main page to create a new playlist, you will see the 

template is listed in the template list. 

 


